Automating a Manual Machine

Converting the PM 728V-T mill to CNC



Step by Step Instructions

For mechanical conversion and software setup.
Prepared by Ron Ginger and Joe Katona
For
Cyle Miller of Meade 46 Schools, South Dakota
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Materials

This slide set details each step.
A USB Memory stick is provided that contains the software.
A single sheet exploded view of the machine is shipped with the machine.

After the Mach4 software is installed a folder of documents will be found at

C:\Mach4Hobby\Docs



Software Llcense

Mach4 is licensed software.

For this project 4 registration codes, equivalent to a coupon code, are provided.
The software must be installed before a license can be generated.

Each license will be keyed to one laptop PC.

The procedure to get the license is explained near the end of this document.



Extra Parts

Memory stick, with software

Two angle brackets to mount Y aX
limit switches. —

Spacer for Z axis switch
Couplings for X and Y axis
Strain relief connector for VFD cable

Target for X limit switches

Target for Z axis limit switch




Move mill to a safe workplace

e The mill is heavy- 370 pounds
e Do not attempt to lift if by hand

e Since we will need to disassemble the mill it may be wise to do it before
moving to a work space



Background

We are working with a 3 axis mill

Each axis is moved by a lead screw with a large Acme thread

For plain threads to move there must be some clearance between the threads
This clearance leads to backlash

Backlash leads to inaccurate parts and broken tools.

A ballscrew solves the problem by placing ball bearings

— i in the screw.

vy /[ We will be replacing the lead screws with ballscrews on
A all 3 axes

Green slides are background information



Dovetall slide with gib

Machine tables must slide freely, but not be loose in any direction.
A dovetail joint has two sides angled to create an interlock
A tapered gib strip slides in between two faces to take out any slack

An adjustment screw can push the gib into the joint to make it tighter.

There is an adjustment screw at each end of the gib to lock it in place




Remove the head (optional)

It is possible to change the Z axis screw with the head in place, but |t IS safer to
remove the head. bt

It will require two people to carry the head.

e Brace the head off the table with a block of wood S
e Or support it with a sling and crane. \
e Remove the two nuts on the side of the head
e Pull the head away from the column.

Store the head on its back in a safe place.



Remove the table

The table must be removed.

It weighs over 50 pounds, so have two people
move it.

Remove the handwheel. Note it has a set screw
above the key.
Remove the end cap-bedring at each end of the
table.




Remove the table- 2

e Remove the gib adjustment screw
Slide out the gib
Slide the table off the saddle. It will slide over

the lead screw.
e Remove the leadscrew and its mid bearing.




Remove the saddle

e Remove the handwheel from the Y axis

e Remove two screws from the Y axis
bearing

e Slide the Y axis bearing off the screw




Remove the saddle (2)

e Remove the Y axis gib adjusting screw and
the gib

e Slide the saddle forward to extend the screw
out of the base

e Remove the screw that holds the Y axis nut. =

e Reaching through the base casting slot grasp
the screw and drop it out of the base. The nut
will remain on the screw.




Remove the Z axis screw

e Block the head or its mount if you removed the

head.
e Remove the blank cover at the top of the

column.




Remove Z axis screw (2)

Remove the nut at the top of the Z
axis screw

Remove the screw that holds the Z
axis nut
Reach in the slot in the column
casting, grasp the screw and push
it back to pull the nut away from the §
slide.




Remove the Z axis screw

e Use a punch or rod to tap the Z axis screw out
of the bevel gear. Use caution to catch the
gear so it doesn’t fall to the bottom of the
column.

e Remove 4 screws to release the bevel gear
assembly on the side of the column.

e Pull the gear assembly out of the side of
column casting.

e Pull the z axis screw out the top of the column




Part 2- Reassembly of the mill

With all the lead screws removed we start replacing them with the ballscrews.
The ballscrews come with the nut on it in about the center of the screw.
Use extreme caution to ensure a nut does not get to the end of the screw.

If the balls are released from the nut it is essentially destroyed.

Green slides are background information



Clean and oll

As you reassemble the mill carefully clean all the sliding surfaces.
Wipe on a thin film of Way Qil to all the sliding surfaces, including the gib strip.

Keep the ballscrew clean. It is pre-oiled by the manufacturer and wrapped in
plastic.

Green slides are background information



Installing Y axis ballscrew

e The saddle should be in place on the
base slides.

e The Y screw is the shortest.

e The Y nut casting is the shortest.

e Slide the ballnut through the Y axis
casting and secure it with four M5 x25
screws, washers and lock washers.




Installing Y axis ballscrew (2)

e Slide the ballscrew assembly under the saddle
with the threaded end toward the front of the mill.

e Be sure the sliding dust cover is in place and the
nut goes through the opening.

e Extend the end of the screw through the hole in
the front.

e Hold the nut mount up and slide it into the hole in
the saddle casting.

e Fix it with the M6-1x25 bolt down through the
saddle.




Installing Y axis ballscrew (3)

e Place two 7201 ball bearings into the Y axis
bearing casting

e Note the bearings must be placed with the
part numbers facing together

e Slip the bearing casting over the end of the
ballscrew.

e Apply the locknut to the end of the shaft and
tighten fully. It may be necessary to hold the
ballscrew with a plier. Hold it at the extreme end
where the nut will not travel, and use somethjng
to provide a cushion for the jaws of the pliets.

e Bolt the casting to the front of the base.




Installing the X axis ballscrew

e Slip the ballnut into its casting and fix with
four M5x25 screws, washers and lock
washers.

e The threaded end should be to the left
side when facing the machine.

e Place the screw on the saddle. Fix with
two M6-1.0x20 screws. =




Installing the X axis ballscrew (2)

e Place two 7201 ball bearings in the Xbearing
casting. Note the numbers on the bearings
must face each other.

e Slip the bearings onto the left end of the X
ballscrew.

e Place a locknut on the end of the ballscrew and
tighten it fully.

e C(Clean the table sliding surfaces and rub on a
thin film of Way oil.




Installing the X axis ballscrew (3)

e Carefully align the dovetails and slide the table onto the
saddle.

e Wipe Way oil on the gib strip and slide it into place.
Note one end is thinner, it goes into the slot first.

e Replace the gib adjusting screw and tighten it down to
the gib.

e Check that the table slides without binding or wobble.

e Hold the X axis bearing up and slide the table to it.

e Fix the bearing block to the table with two M6-1.0x16
SCrews.



Installing the Z axis ballscrew

e Slide the Z axis ball nut into the bearing
casting.

e Fix it to the casting with 4 m5-1x25 screws
washers and lock washers.

e Slip the ballscrew into the top of the column
casting.

e Align the nut castings with the hole in the
head slide.

e Fix it with one M8 x35 screw.



Stepper Motors

Each axis will be driven by a stepper motor.
A stepper motor does not run continuously like a normal motor, It only makes a small step each time it is pulsed.
An electronic driver box is needed to send the proper pulses to the motor.

Simple steppers are ‘Open Loop’, that is, there is no feedback from the motor. A step is requested but the
controller does not know if the movement was complete.

If some mechanical overload occurred the motor will ‘miss steps’

We are using ‘closed loop’ steppers. They have an encoder on the shaft so the electronics can tell if the step was
actually made.

If an overload occurs an error signal will be sent back to the computer.

Green slides are background information



Motors (2)

e Stepper motors make 200 steps for one revolution.

e Drivers can be designed to divide steps into ‘micro steps’ for smoother
operation.

e Drivers have ‘dip switches’ to set the number of micro steps.

e We will use 8 micro steps on X and Y and 16 micro steps on Z.

Green slides are background information



Motors (3)

e Stepper motors are offered in many sizes, based on the torque it can
produce.

We are using motors on X and Y that produce a torque of 439 oz-in.
On Z our motor is 1128 oz-in.

Motor sizes are standardized by NEMA.

We are using NEMA 23 on Xand Y and NEMA 34 on Z

In general, more torque means a motor can push(accelerate) a load
faster.

Green slides are background information



Motors (4)

Motors must be connected to the
ballscrews with a coupling

Couplings are designed to tolerate small
misalignment of the axes, but still not
have any backlash or slip.




- Angular contact Suppart N
™ bearing pakr bearing unit




Installing the X axis motor

The X axis has a bearing mount casting at the §& . lfl '
left end of the table. — "

The casting contains two angular ball bearings
back to back.

A locknut restrains the bearings and provides
pre-load to them. The pre-load should be just
enough to prevent end play. Too much pre-
load will prematurely wear the bearings.



Installing the X axis motor (2)

At the right end of the ball screw install a
coupling.

Align the dovetails and slide the table on.

Mount the casting to the table with 2 M5-1
screws

Slip the motor shaft into the coupling
Align the base of the motor with the casting

Bolt the motor on with 4 M5-1 screws.




Installing the Y motor
The Y ball screw has a bearing and motor mount
casting on the front of the machine.

Place two ball bearings into the casting so that the
part numbers face each other..

Slide the casting onto the ball screw. > i

Fix the casting to the front of the base casting.

Place the locknut on the screw end anéAighten it to
pre-load the bearings. Fe



Installing the Y motor (2)

Place a coupling on the shaft.

The Y axis motor casting surrounds the
coupling on 3 sides.

Hold the casting with the slot down.

Slide the motor shaft through the casting
and into the coupling.

Mount the motor with 4 M5-1 bolts through
the motor flange and the casting.

Tighten the coupling through the slot.



Installing the Z axis motor

Slide the head mount up until the ball screw
end is at the top of the column.

Place two ball bearings into the Z mount
casting.

Slide the bearings onto the shaft end.

Place the lock nut on the end of the screw
and tighten it to pre-load the bearings.

Adjust the head mount until the motor mount
casting is on the top of the column.




Installing the Z axis motor (2)

Place a coupling on the end of the screw.

Place the Z motor on top of the casting and
slip the shaft into the coupling.

Tighten the coupling.

FIx the motor with 4 M5-1 screws.




Motor Cables

'Power
P Extension

DB to RJ adapter

i ’ L



Motor Cables

Connect a motor extension cable to each motor
Connect the extension cable to the control box

Connect a DB to RJ adapter to each motor encoder cable. Be sure to tighten the
strain relief screws.

Connect an RJ45 cable to each adapter

Connect the RJ encoder cable to the control box.



Arrange the motor cables neatly.

Be sure the X axis cable has enough slack
to allow its full motion.

Use wire ties or cable clamps to tie cables
neatly along the machine.




Switches

Control systems often need to know the
position of mechanical components.

Switches can Detect end points or reference
points.

Proximity (“Prox”) switches are active
magnetic devices that respond to
ferrous(iron).

We will use Prox switches in this
conversion.

Green slides are background information



Home Switches

When the control software is started it has no way of knowing the tool location
relative to the table.

Each axis is equipped with a proximity switch at the extreme home (Positive) end
of its travel.(remember we refer to the motion of the tool, not the table)

A Prox switch can detect when a ferrous metal comes close to it. No actual
contact is needed.

A ‘Reference’ operation must be done each time the software is started. This
moves the axis to its positive limit of travel. This is called “Homing the Machine”.

Green slides are background information



Limit Switches

Operator error or program errors may drive an axis past its maximum limit of
travel.

Such a move could do damage to the machine.

To prevent damage a Limit Switch is installed at the ends of travel.

The limit switch will signal to the software this end condition.

On the positive end of travel we can use the same switch as the Home switch.

A switch at Z negative is not used because any tool will hit before the limit can be

reached

Green slides are background information



Switch Cabling.

All five limit/home switches are supplied connected to one block.
This block has an RJ45 jack for an extension cable to the control box.

Be sure to uncoil all the switches before attaching them to the machine to remove
twists from the cable.

Green slides are background information



X axis home and limit switches.
The Switches are mounted at the ends of the
saddle casting.

Hold the switch in position aligned with the upper
edge of the saddle and it's right or left edge.

Mark the switch mounting holes. Center punch
each hole location.

Drill a hole for an M3-.05 tap, tap each hole.




X axis home and limit switches. (2)

Mount the switch to the casting with the
M3-.5 screws provided with the switches.

Adjust the switch to be just under (1/16")
the table edge.

Remove the table stops and the center
fixed stop.



X axis home and limit switches (3)

Fix the steel blocks to the
table front slot at each end.

Route the switch leads under
the table and wrap them to
the oil line.



Y axis switches

The Y axis switches are mounted to the base casting on the left side under the
table.

An aluminum angle bracket is provided for the mount.



Y axis switches (2)

Position the bracket at the end of travel with |
its back edge against the base casting raised
area.

Drill a hole and tap it M5-1

Mount the Y+ switch to the angle bracket and
the bracket to the base.

Check to see that the switch is adjusted to
clear the saddle casting by about 1/16 Inch




Y axis switches (3)

The rear switch is mounted like the front.

Position it to align with the saddle closest
to the column.




Z axis switch

Z axis has only a single switch for Z home

We repurpose a screw that holds the cover plate
from the removed Z axis crank.

An aluminum spacer block is held into the
casting corner with one M5-1.0 screw.

The spacer block has tapped holes to hold the
switch.




Z axis switch (2)

Steel block is provided for the Z axis switch.
Locate it on the head just above the oil fitting.

Drill and tap a hole and mount the block.




Spindle Control

The Spindle is powered by BLDC (Brushless DC) motor.
Motor driver can be controlled by CNC computer
Control requires Two relays, FORWARD and REVERSE

A 0-10Volt signal controls motor speed. This signal is generated by a PWM (Pulse
Width Modulation) from the control.

Green slides are background information



Spindle Control

Remove front cover of Spindle control box
CAUTION: Be sure to unplug the box.
Drill 72" hole in bottom of box

Use a step drill to make a neat hole.



Spindle Control (2)

A cable is supplied with an RJ45 jack on one end and
nothing on the other.

Insert end of wire through strain relief.

Tighten the nut to apply compression to the wire.
Insert strain relief into hole in box.

Place nut on to capture the wire.

Crimp ferrules onto wire ends.

Plug the RJ45 jack into the VFD jack on the back of the
control box.




Spindle Control (3)

Remove the 7 pin connector from the main
control board

Replace the connector with the connector
from the small speed control board.

Plug in the two wire power connector from
the speed control board.



Spindle Control

Connect the 5 wires from the strain relief
connector to the speed control board.

Forward-Blue
Reverse-Green
Common- Brown
Cntrol Voltage Orange
Common Voltage - White\Orange




Leftover parts

PM supplies sheet metal covers
for the X and Y motors.

But these are made for open loop
steppers.

Closed loop steppers are longer,
so the covers don't fit.

The Mill will work fine without
them.
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Motion control

Ethernet Smoothstepper

Converts commands from Mach4
into stepper motor pulses.




Set up PC

Mach4 requires a PC running Windows 10 or 11. Use common windows setup, no
extra software is needed, or desired, this PC should only be used as a machine
control.

Install Mach4 from memory stick, Or download file from downloads tab at
https://machsuspport.com

Also requires a plugin from Warp9 tech on the memory stick or Download from
https://warp9td.com



Documents

Mach4 provides many manuals when installed
C:\Mach4Hobby\Docs

The ESS has many pages of on-line documentation
https:\\Warp9td.com

This document is a simplified guide to the installation.

If questions arise see the above sources.



Mach4 Profile

A PC can be setup to run several different machines.

Each machine has a separate configuration appropriate to that machine.

The configuration is saved in a folder C:\Mach4Hobby\Profiles

When installing Mach4 you will be asked for a profile. Create a meaningful name.
In the sample screens here we used MyMi 11 as profile name.

DO NOT use one of the system profile names, it will be overwritten if you upgrade
the software.



Optional profile

We have provided a profile suitable for the PM728.

We called it MyProfile.

A copy is on the memory stick.

Copy the file from the stick and put it in the profile folder.
C:\Mach4Hobby\Profiles

All of the following configuration steps are completed in this profile.



& MachdMill Properties *

. Security Details Previous Versions
PrOflle (2) General Shortcut Compatibility
@ Mach4Mill
The Mach4 install will create some Target type:  Application
desktop ICOﬂS Target location: Mach4Hobby
Target: [E-WochaHobby\achdGUI exe /o Nachanulj
Right click on the icon for Mill. | N
Start in: |C:'-.Mad14Hnbb:.' \
\
Select Properties Shottout key: [None
. . Bun: Momal window ~
The Target line will have the start e

command for Mach4, followed by the FEE——— [[E—— ———
profile name. Edit this to the name you
have given your profile.

You can now start Mach4 with a double
click




& Mach4Mill Properties

. Security Detailz Previous Versions
P rOfI I e (3 ) / General Shortout Compatibility

b/ ﬂ;_

Description:  Mach 4 CHNC GUI

Change to the General ta

Shortout (Ink)

Replace the name with
your profile name.

Location: C:3Users'win10userDesktop
Size: 152 KB {1,561 bytes)
Size on digk:  4.00 KB (4,056 bytes)

Created: Frday, June 2, 2023, 11:32:30 AM
Modified: Frday, June 2, 2023, 11:32:30 AM

Accessed: Today, June 2, 2023, 11 minutes aga

Mtibutes: | Readonly [ Hidden Advanced...

Cancel Apply




Mach4 Install

* | = | Downloads

- He Se V
Flnd the Insta” flle_ <« A * » This PC » Downloads &

~

Search Downloads

Mame Date maodified Type Size

3+ Quick access

Double click it. =——————mouer » [ Yesterday (1)
—»‘i MachdHobby_Installer-4.2.0.5036 6/1/2023 5:59 PM Application 20,738 KB
; Downloads b Y. PP

|i§-'| Documents *

&= Pictures +
J‘! Music
m Videos

@ OneDrive

= This PC
- 30 Objects
I Desktop
|i§-'| Documents
; Downloads
J‘! Music
&=/ Pictures
m Videos
e 0S(C)
e USE Drive (0]

1item




Mach4 Install

Check to accept license
terms

Click Next —

&, MachdHobby CNC Software Version 4.2.0 Build 5036 Setup —

License Agreement
Flease review the license terms before installing Mach4Hobby CHNC Software Version
4,2.0 Build 5038 .

Press Page Down to see the rest of the agreement,

X

—- Wotice of Lighility —-—

Itis the nature of all machine tools that they are dangerous devices. In order to be

permitted to
run Mach4 on any machine you must agree to the following:

I agree that no one other than the owner of this machine will be, under any
drcumstances, responsible for the operation, safety, and use of this machine. I agree
there is no situation under which I would consider ArtSoft or any of its distributers to be
responsible for any losses, damages, or other misfortunes suffered through the use of

\agreement to install Mach4Hobby CNC Software Version 4. 2.0 Build 5036 . Click Mext to
continue,

|} i :
@ the terms of the License Agreement;

W

If you accept the terms of the agreement, didk the check box below. You must accept the

‘bl Next > | Cancel




Mach4 Install

Observe the warning
message!

Click Next

&, MachdHobby CMC Software Version 4.2.0 Build 3036 Setup — >
Choose Install Location
Choose the folder in which to install Mach4Hobby CMC Software Version 4. 2.0 Build 'ﬁ

5036 .

HIWWARNING!
™. Unless you are very familiar with Mach4 and absolutely certain you do not want to install in

the default location {C:\Mach4Hobby) for some reason, GO WITH THE DEFALULT and save
yourself some grief.

Destination Folder

| C:\Mach4Hobby| Browse...

Space redimeaed=0.4 MB
Space available: 197,050

< Back Cancel




&, MachdHobby CNC Software Version 4.2.0 Build 5036 Setup = 4

Mach4 Install Choose Components

Choose which features of Mach4Hobby CMC Software Version 4.2.0 Build 3036 you .."j.'
want to install,

UnCheck type of Check the components you want to install and uncheck the components you don't want to
machines you are not install. Click Install to start the installation.

using. — N
Select Machine Control Types Lathe Desaription
Click Install Elre
I vil_62is
\ ] Router
[] Tangential
[] Plasma
Space reguired: 348.6 MB

< Back Install Cancel




Mach4 Install

Wait for progress bar

& MachdHobby CNC Software Version 4.2.0 Build 5036 Setup

Installing

Please wait while Mach4Hobby CMNC Software Version 4. 2.0 Build 5036 is being

installed.

S

< Back

Next >

e

Cancel




Mach4 Install

Click Finish

@) MachdHobby CNC Software Version 4.2.0 Build 3036 Setup —

Completing Mach4Hobby CNC
Software Version 4.2.0 Build 5036
Setup

Congratulations! Mach4 has been successfully installed on
your computer.

=*=Tt is highly recommended that you use the loader to
COPY one of the default profiles (saving it as something
unique) and configuring the newly created profile for your
machine, ***

[]iets get started, launch the Mach4 Loader now.




Mach4 Install

Mach4 will start and
show the profile select
screen.

Select Your profile then
Copy

Click OK

Select Profile

Current Profiles

MachdlLathe

Machamill

Machdhill_BAxis

Create Praofile

Copy Profile

Restore Backup

Delete Profile

Import Profile

Cancel




Screen Set

Mach4 has a built in screen editor

You may use it to modify any part of a screen

You may add or remove buttons.

You may change colors or type fonts.

You may add controls.

Screens can be fully customized, but start with one of the pre-built screens

You may switch screens at any time during operation.



Mach4 Install

Copy profile will ask for
screen choice.

Select wx4.set for mill

Click OK\

Select the screen set...

ui « Mach4Hobby » Screens
Organize - Mew folder
A
& Onelrive Mame
7| Blank.set
= This PC |J _
ngrave_Marking.s
T ) | ] Eng Marking.set
- 3D Objects |J wicd st
I Desktop R
= Documents L] wock ize: 2.99 MB
; Downloads
J‘& Music
&= Pictures
m Videos
g, 05 (C2)

- WSB Drive

Type: SET File

Date medified: 12/16/2022 2:05 PM

File name: |wxd.set

Search Screens

Date medified

2/8/2019 10:42 AM
1/17/2020 5:39 PM
12/16/2022 2:05 PM
12/16/2022 2:05 PM

9/28/2022 10:06 PM

-

o @

Type

SET File
SET File
SET File
SET File
SET File

Cancel



Mach4 Install

As Mach4 Starts it will
try to use some internal
network functions.

Windows will show this
block warning.

This will only happen
on the first time start

up.

@ Windows Security Alert

@ Windows Defender Firewall has blocked some features of this
app

Windows Defender Firewall has blocked some features of Mach 4 CNC GUI on all public and
private networks,

@ Mame: ach 4 CMC GUI
. Publisher: Mewfangled Solutions

Path: C:ymach4hobbymach4gui.exe

Allow Mach 4 CMC GUT to communicate on these networks:
[ ]Private networks, such as my home or work network

Public networks, such as those in airports and coffee shops (not recommended
because these networks often have lite or no security)

What are the risks of allowing an app through a firewall?

Allow access

e ——

— Gg.]lnw aCCess Cancel



© Mach 4 - Demo
ile Vi onfigure
urrent Positions | Progra en

SUCCESS! Mach4
is installed.

G Code | MDI

Before we can run
we need to install a
plugin for motion
control.

: | Run Ops | Tool Path Ops Jogging

Stop Mach4 with
the X




Mach4 Install

Mach4 will build a
screen icon for each
machine type you
selected.

Convert one of them to
be your profile.

Right click on the icon
and select Properties

& MachaMill Properties

Security Dletails
General Shorteut

.@ Mach4Mil
7

Target type: Application

Target location: Mach4Hobby

Previous Versions
Compatibility

—

Target: “MachdHobby\MachdG Ul exe /p

Start in: |C:'-.I'\"Iach4H0hb:.'

Shortcut key: |None

Bun: MNomal window

L

Comment: |Launch Profile

Open File Location

Change Icon... Advanced...

Cancel

Change the profile name to
the profile you created.



Mach4 Install

Change to the
General tab

Change the namey
your profile name

Click OK

\

The desktop icon will
now start Mach4 with
your custom profile.

Security
General

7

Location:

Size:

Size on disk:

Created:
Modified:
Accessed:

Attributes:

& MachdMill Properties

Details Previous Versions
Shortcut Compatibility
[MachHil
Shortcut (Ink)
jion:  Mach 4 CNC GLI

CAUsers'win1lusertDesktop
1.52 KB {1,561 bytes)
4.00 KB {4,096 bytes)

Friday, June 2, 2023, 11:32:30 AM
Friday, June 2, 2023, 11:32:30 AM

Today, June 2, 2023, 11 minutes ago

[JBeadonly [ ]Hidden Advanced. ..

Cancel Bpply



ESS- Ethernet Smooth Stepper

The motion control- ESS- requires a software driver, called a plugin.
It is supplied on the memory stick with this system.

To check for a newer version look at https://warp9td.com/

Download the .zip file ESS_Mach4 _vi##i#.zip
#H## indicates the version number.

Open the .zip file and copy the two files


https://warp9td.com/

ESS plugin install

Pinto Quick Copy Paste

Using File Explorer navigateto =
c:\Mach4Hobby\Plugins S
Paste the two files into this g

folder ”

Mach3
. Mach4Hobby
Warp9Mach4.sig perfLogs
Program Files
Warp9Mach4.m4pw e
gramData
scratchdir
Users
WCH.CN
Windows
& 178 (Dv)

== DVD RW Drive (E:)

;i J dhy ut
= |

w- Copy path
[7] Paste shortcut

EE| x -J;;

Copy Delete Rename
to~ -

Organize

» ThisPC » Windows (C:) » MachdHobby » Plugins

-~

Mame

7 IuaS3.dil

| mcKeyboard. mdpw
| mcKeyboard.sig

| mclua.mdpw

| mcLua.sig

| mcModbus.mdpw
| mcModbus.sig

| mcRegfile.mdpw

| mcRegfilesig

| mcSerial.mdpw

| mecSerialsig

| mecSurfaceMap.mdpw
| mcSurfaceMap.sig
| meXBaox.mdpw

| mcXBox.sig

| meXheMpg.mdpw
| meXheMpg.sig

| ShuttlePro.mdpw

| ShuttlePre.sig

New
folder

TLE MEW ILem ~

¥ | Easy access ~

Mew

P




Mach4 Install

& Mach 4 - Demo

DOUble CIiCk your prOﬁIe MaCh4 icon File View Configure Diagnostic Wizard Operator Help

Select Motion Dev... -
Program e Mapping Engrave | Trace

When Mach4 starts select the — e
Currem Ugins...
configure menu bar item

Select Control

. Wachine | Distance )|
| e | | T | I

G Code MDI




M ach4 I nsta | | Control Configuration MyMill:0
Defaults General PIUQIHS Motors  Aux. Positions Axis Mapping Hom
Select the ESS plugin Enabled Description Version
1 | of Core - Newfangled Solutions 4.2.0.5036
Click OK 2 | ] Keyboard Inputs - Newfangled Solutions 4.2.0.5036
3 | of LUA - Mewfangled Solutions 4.2.0.5036
Shutdown Mach4 4 4 Meodbus - Newfangled Solutions 4.2.0.5036
5 of Regfile - Mewfangled Selutions 4.2.0.5036
Restart MaCh4 to Start the ES 6 4 Serial - Newfangled Solutions 4.2.0.5036
. 7 & Surface Map - Newfangled Solutions 4.2.0.5036
pl ugln ' 8 - 4 ABox Controller - DazTheGas and Newfangled | 2.1.3
Q - 4 ZhcMpg - Newfangled Solutions 4.2.0.5036
10 uf ShuttlePro - Newfangled Solutions 4.2.0.5036
1 - uf simulator - Newfangled Solutions 4.2.0.5036
12| 4 WarpRunner v 002 - Warp9 Tech Design, Inc.  0.002
13 uf ESS w284 - Warp9 Tech Design, Inc. 1.0.1.284




Select Motion Device X
Mach4 Install
Select the motion control device,
WARNING!
Changing the motion control device will destroy any existing
When Mach4 starts select axis to motor mapping and moetor tuning.
Conflgure ..... Simulation Device

Ethernet SmoothStepper

Select motion device
Choose ESS
Click OK

Shutdown Mach4

oK Cancel Apply




ESS Setup [I:]\Qwapssmomh«pp ~Search x| J§ Home x |+ — g b3

https://warptd.com A s = $ o

ome Product Details Getting Started Help Software

Welcome to Warp9 Tech Design, home of the Ethernet and USB
SmoothStepper motion controllers!

ESS support for Torch Height Control
ESS suppor

for Laser Vectoring and Rastering (pictures)

Backlash Compensation
PID Spindle Control

Multiple RPM updates per revolution

Lathe Threading

. - _ . 1145AM
H £ Type here to search i 7| Russell 2000 @M gpoppy

Browse to https://warp9td.com

Follow the directions to download the SCU application. There is also a great amount of
background on setting up the ESS


https://warp9td.com

im) ‘ QO warp9 smoothstepper - Search X [I§ Software x IS8 - (a] X

L5 ] &) http

E S S S et u p —— V. rp3d _lech design, inc. )

'fwarp9td.com/index.php/sw A g ¥ ® 9

Home Product Details Getting Started Help E: I b Documentation FAQ Forum

Order Distributors Solution Partners Break Out Boards Register for Forum Privacy

Current Software Page

Which piece of software are you looking for:

ﬂ 2 Type here to search / i @ s5°F sunny
Select the SCU



Select Setup Language =

SCU setup

i—'-:':-. Select the language to use during the
'E,;:_ installation.

Start the SCU .

Select Language Cancel

f@. Setup - Warp9 Tech Design - 5CU Application — *

Select NEXT

Information
Flease read the following important information before continuing.

When you are ready to continue with Setup, dick Next.
Thank you for purchasing an Ethernet SmoothStepper (ESS)!
This installer will:

1) Install the ESS's System Configuration Utility (SCU).
2) Launch the SCU, which will configure your computer to communicate with the ESS.

Cancel




ESS Setu p i"_@ Setup - Warp® Tech Design - 5CU Application — X

Select Destination Location
Where should Warp2 Tech Design - SCU Application +2.0.5.8 be installed?

Use the suggested folder

Setup will install Warp2 Tech Design - SCU Application v2.0.5.8 into the
following folder.

To continue, dids Mext, If you would like to select a different folder, dick Browse.,

C:'Program Files (x86)Warp2 Tech Design Browse...

Select Next to install \

At least 6.9 MB of free disk space is reqiied

= Back Cancel




ESS S t & Setup - Warp9 Tech Design - SCU Application -

Information
Please read the following important information before continuing.

Note the instructions.

When you are ready to continue with Setup, dick Mext.
When the SCU starts, it will guide you through:

1) Installing Mach (if you have not done so already).
2) Installing the ESS's plugin for Mach {if you have not done so already).

3) Configuring your computer with “Easy Mode”,
Se|eCt N eXt 4) Detecting your ESS,
5) Run "Windows Performance Tuning”, so Windows will can run its best with Mach.




ﬁ;._-_' Setup - Warp9 Tech Design - SCU Application
ESS Setup
Completing the Warp9 Tech
Design - SCU Application v2.0.5.8

Select Finish Setup Wizard

Setup has finished installing Warp3 Tech Design - SCU
Application v2.0.5.8 on your computer, The application may
be launched by selecting the installed shartcuts,

Click Finish to exit Setup.

1 aunch Warp3 Tech Design - SCU Application v2.0. 5,8

< Badk Einish




@ SmoothStepper System Configuration Utility v, 2.0.5.8 — O

ESS Setup |~

Thank you for purchasing an Ethernet SmoothStepper (ESS)!

This System Configuration Utility (SCU) will help you install the Mach Software, the ESS Plugin and then configure your Windows PC to
communicate with your Ethernet SmoothStepper (ESS).

MNaotes:
1) Look for the flashing buttons or text, to help guide you.
2) Hover aver buttons for maore information.
3) If you cannot get any communications from your ES5, please check your Ethernet cable and Power Cycle the ESS.
4) This SCU will not work with the USE SmoothStepper (USS)

1: Download Mach (optional) | | 2: Download ESS Plugin [optional) | | 2: Start Pi Configuration

Use option 3 =—




&2 SmoothStepper System Configuration Utility v. 2.0.5.8 - O X

ESS Setup File Help

Please cheose one of the following to configure your computer:

* Most people will use "Easy Mode', since it will configure everything in 3 mouse clicks! Your SmoothStepper will use the factory default settings
and connect directly to your computer (Most Commen),

* "Wizard Mede' guides you through the setup and configuration process, but requires some networking knowledge.

* ‘Advanced Mode' is for advanced troubleshooting.

Go Back | | Easy Mode | | Wizard Mode | | Advanced Mode

This will help guide you through the configuration process. |

Select Easy Mode -~




ESS Setup

The SCU will show
several changes it
makes to the firewall
settings.

Go to the next step /

f@_ Configure Firewall

File  Information  Actions

Step A: Add rules to allow Mach programs through the firewall

Go to Mext Step |

Allow Mach 3 and Mach 4 ‘ HELF GUIDE ME

el

Step A Add rules to allow Mach programs through the firewall.
* By clicking on "Allow Mach 3 and Mach 4" you will add rules to t
communicate through the Firewall as needed. The default instal
** C:\Mach3'Mach3 exe
** C:AMach4 Mach4G U exe
** C:AMach4 wxMach exe
** C:vmachdhobby Mach4GUlLexe
** C\Machdhobby wmach .exe

indows Firewall explicitly allowing these programs to
ions will be used:

Go To Mext Step.
* The Windows firewall
Mext Step™.

d be corfigured to work properdy with your Ethemet SmoothStepper. You may now click on "Go To

Motes:
g clicking on "Menu -> Information -> Firewall Details”, you will be able to see all of the details regarding the Windows Firewall
d any other Firewall or Antivirus software installed.

* By clicking on "Menu -» Actions -> Reset Windows Firewall To Default” you will reset the Windows Firewall to its default rules
and an active state.

* By clicking on "Menu -> Actions -> Open Windows Firewall” you will open the Windows Firewall interface. The modffications
made by this program will appear in the "Inbound Rules” section.

* By clicking on "Menu -» Actions -> Enable Firewall”, you will enable the Windows Firewall. This is the recommended way to
run with the Ethemet SmocthStepper.

* By clicking on "Menu -» Actions -> Disable Firewall”, you will dizable the Windows Firewall. Thiz is NOT recommended, since
Windows Defender iz sometimes activating and block communications with the Ethemet SmoothStepper.




&Z SmoothStepper System Configuration Utility v. 2.0.5.8 - O X
ESS Setup o oo et

Step 3: Configure the Adapter so it can talk with the Ethernet SmoothStepper:

This will let you configure your network adapter so it can communicate with the Ethernet SmoothStepper. Left click on 'Adapter Configuration'

Select Adapter
Configuration =—

=P Rdapter Configurati | | Refresh Details

Detected Network Adapters

I AdapterName Type Status BytesRX Mode AdapterlP Adapterinfo
1 | Ethernet 4 Ethernet| Up 192 DHCP  169.254.212.121| Intel(R) Ethernet Connection [219-LM




ESS Setup

Select Recommended

We strongly advise that you use the ‘Recommended ESS Configuration'. These settings will automatically work with the default factory
address of the SmoothStepper.

‘Set Configuration Manually’ should only be used by experienced users, or to set your adapter to custom settings.

Step |

settings™

Apply settings

] | Recommended ESSConﬂg_l.lraﬁnn| | Set Configuration Manua[lx__l

50 to Next

This will set your network adapter t recommended settings to communica ESS. |

&2 Configure Adapter Wizard - O X

By pressing 'Apply Settings Now' these settings will be applied to your network adapter, which should then be able to communicate with
your Ethernet SmoaothStepper.

MNote: Your Ethernet SmoothStepper is set to an IP address of 10.9.9.9 You DO NOT want to have the Network Adapter's IP address set to
that value. However we are setting the Gateway to 10.9.9.9, which will let the network interface show if it is connected to the Ethernet
SmoothStepper.

Go to next step —

Go Back | | Apply Settings Now Go to Next Step
Adapter Name LT
Adapter [P 109.9.2
Adapter Subnet 235.255.255.0
Adapter Gateway 10999




| : ;: ; : ;etu p &2 SmoothStepper System Configuration Utility v. 2.0.5.8 - O X

File Network Adapter Types Help

Step 4 Listening for Ethernet SmoothSteppers ¢

The 'Detected ES5(s)' table (at the bottom of this window) will update every few seconds with any detected ESS(s), but it may take up to a
minute for the first ping to show up (if there is an ARP issue).

If your E55 appears choose Windows Performance Tuning from the File menu.

If your SmoothStepper does not appear within a minute click on 'l don't see my ESS'

I don't see my ESS | | Refresh Details |

Detected Network Adapters

. ID AdapterName Type Status BytesRX Mode Ada;:terlP Adapterinfo
SeIeCt WlndOWS | 1 |Ethernet4  |Ethemet|up  [192  [Ststic [100.9.2 |intel(R) Ethemnet Connection 1219-LM |
Performance Tuning ~—

| To change visible network types (Wireless or Wired Ethernet), you can g

Detected SmoothSteppers: appears below, choose Windows Performance Tuning from the File menu

ID SmoothStepperMALC
0 |Listening for SmoothSteppers...

SmoothStepperinfo  AdapterType AdapterlP SuccessfulPings BootPRxd

Pings, open Windows Performance Tuning |




ESS Setup

Continue to choose
default settings

@ Windows Perfermance Tuning

Welcome! Let’s talk about how Windows settings can impact CNC operations

Great! Your Windows settings have been saved successfully!

Mow let's compare your settings with those we recommend for use

You may see variations
from this series of
screens. Just accept all
defaults until SCU is
finished.

Read the docs on the
warp9td.com site for
further detail.

‘bl Review Recommen ded Actions

with your CNC machine.

Build Support Log




Machine Configuration

The ESS has 3 ports of 17 pins.

Most pins can be assigned as input or output.

The system has several control signals which are connected to an ESS pin
We must associate each signal with the correct pin.

All this data is stored in the Machine.ini file within your Profile.

There is a Machine.ini file on the memory stick supplied with this system.

You may simply copy it from the stick to replace the current file in your Profile.



Active Low

All signals in this system are digital, binary.

That means they may be a HIGH (typically +5V) or LOW (typically ground)
The system needs to know when the signal is TRUE, or ACTIVE

Active High means the signal is TRUE when it is HIGH

Active Low means the signal is TRUE when it is LOW.

There is no right or wrong, here, you just must use whichever choice the system
designer chose.



Machine Configuration

If you want to fully understand the wiring of your machine use the following
screens to config the ESS pins.

The general process is to assign alias names to the pins in the ESS config and
assign the alias names to the correct functions in Mach4.

The following screens conform to the tabs of the ESS Config screens.



Machine Configuration

From the main Mach4
screen menu bar

Select Configure-
>Plugins->ESS

Info screen will open

Work across the tabs

@ Ethernet SmoothStepper (ESS) Configuration v285, Machd build 4.2.0.5036 - Instance 0

Info General Motors Spindle  Laser  Laser.. Analog Pins Config  Input Signals  Output Signals  Heming  Probing  Backlash |

Click here for:  Getting Started: Setting up the SmocthStepper and Machd Please read the Safety Page Warp9TD.com FAQ Warp9Tl

@ WARP9

TECH DESIGN

This plugin recommends using Machd 4612 or newer
Show a waring at startup if Mach4 is clder than that

PLEASE READ! This will help you to set up your ESS (Ethernet SmoothStepper) motion controller plugin.

If you DO have the motion controller board connected, you can freely switch back and forth between this config and Mach's config, and the ch
If you do NOT have the motion controller board connected, do not change settings in Mach's Signals Tabs, Cnly work in this config window,

General Setup Steps:
1) Cenfigure the 'General’ tab and then the 'Motors' tab.
2) Configure the 'Pins Config tab:
* STROMGLY RECOMMEMDED: Use Aliases! It will make it much easier to remember which pins do what.
* Read the Setup Guide for details on Noise Filtering
- If the value is 0, noise filtering will be disabled and the pin's data will not be delayed.
- If you are getting erroneous Limit Switch Hits, add some noise filtering to the limit switches and fix your limit switch wiri
3) Assign pins to your 'Input Signals' tab and to your 'Cutput Signals' tab.
4) Configure the 'Homing' tab.
5) Finally, close this configuration window, and go into the Mach config to finish your systern setup.

oK Cancel



ESS config, tab General

On the General tab leave
all the settings as is.

\F{d Ethernet SmoothStepper (ESS) Configuration v285, Mach4 build 4.2.0.5036 - Instance 0

HC

Info General Motors Spindle Laser  Laser.. Analog Pins Config Input Signals Output Signals  Homing  Probing  Backlash
1) IP Address of the SmoothStepper 2) Buffer Size (seconds, max of 0.5) 3) Plugin Frequency (Hz)
i ~]  [01800 | [40
4) Velocity FIFO Buffer Ran Out of Data 5) Disable & EStop ) Advanced Logging
[] Show Hardware Velocity FIFO Ran Dry Msgs [#] Charge Pump Runs In EStop [JEnable Advanced Logging

Disable Expansion Port In Disable

7) When a Feed Held Event turns an Quput Pin
OFF, prompt the operator before turning the cutput pin ON again
OM, prompt the operator before turning the cutput pin OFF again

1) The motion controller's IP address will be 10.9.9.9 unless it was modified with the configurator.

2) Buffer Size defaults to 0.18 A smaller buffer size is more responsive to Feed Hold commands, but is more sensitive to the
Velocity FIFO running out of data if your computer bogs down. Increase the buffer size to prevent the Velocity FIFO from
running cut of data. If you have received 'Velocity FIFO Ran Out of Data’ messages, you should restart Mach4 after
medifying the buffer size,

3) The plugin frequency is typically left at 40 Hz. Higher frequencies will let Mach respond to events faster, but will also force
your PC to work harder to keep up (which is harder for slower computers to do).

4] This lets you choose to watch the Velocity FIFO, to make sure it does not Run Out of Data. We recommend you leave this
checked. Running out of data may cause lost steps, and may indicate your PC is doing other tasks instead of servicing Machd,

If you get these messages regularly, take these actions so critical data can make it to the motion controller in time:
* Increase your Buffer Size (above).
* Disconnect your PC from the internet and shut off WiFi.
* Shut down all other programs on your PC,
* Decrease your plugin Frequency to 30Hz or 20 Hz (above).
* Visit Warp9TD.com and look at our FAQ Windows page to see how to optimize your PC further.
* If your PC has less than 3 GB RAM (XP), 4GB RAM (Win7) or 8 GB RAM (Win10) you may want to increase your PC's RAM.,

QK Cancel




ESS config tab Motors

w2 Ethernet SmoothStepper (ESS) Configuration - v260

We are USing Info General | M
Ste p/Di r motors Axis Motors Settings: Step/Dir, Quadrature or CW/CCW

UtUI'S Spindle Laser  Pins Config InputSignals Output Signals Homing Probing Ba

i Maode Reported Feed Rate Smoothing (Sec)
on all positions. P P~ o100
Motor 1 | Step/Dir 0.100
Motor 2 Step/Dir 0.100
Motor3  |Step/Dir 0.100
Motor 4 Step/Dir 0.100
Motor 5 |Step/Dir 0.100

[JEnable AntiClunk Mode for Servo Motors

1) In the 'Qutput Signals' Tab, assign Aliases or Pins
for each Motor used.

2) In Mach Cenfig -> Motors, set up the parameters
for each Motor used.

3) In Mach Config -> Axis Mapping, Enable your axes
and assign Motors as Masters and/or slaves,




\‘T@ Ethernet SmoothStepper (ESS) Configuration v283, Machd build 4.2.0.5036 - Instance 0

Info General Motors Spindle laser  Laser.. Analog Pins Config Input Signals Output Signals Homing Probing Backlash HC

. . 1) Spindle Settings
E S S CO nfl g ta b S p I n d | e Spindle Type: ~ | Frequency, Hz: |:|Duty Cycle Zero at Min RPM

" |Spindle Index Input ~ | Averaging Sec  [v]Report Spindle RPM

We use a PWM EncoderPrescaIer * Effective PPR = |1 Total Enceder Pulses/Rev
2) Spindle PID Settings (Only for PWM Drive Mode)

S|gna| to Control [ UsePID Use PID For Threading 55_PID_LOG.csv
Splndle RPM Kp |0.0000100 | Ki |(0.0000000 | Kd |0.0000000

Use PID Ceiling 20.00 % of commanded RPM Uze PID Floor | 95.00 %

We dO not have a 1) Choose a Spindle Type of:

* Relay or none - The spindle/router is controlled by relays or there is none
* 0B - Qut of Band (Step/Dir, CW/CCW or Quadrature)

S pl N d I e | nd ex Slg nal ) * PWM - Pulse Width Modulation Spindle Speed control

The 'Qutput Signals' tab has dedicated Spindle pins for your system's relays:
. . * Spindle Dir - Retains the current spindle direction even when the spindle stops.
Ba r WI | I re mal n The state changes only with a direction change (prevents direction glitching)
* Spindle On - Active when the spindle is active
* Spindle Fwd - Only active when the spindle is running forwards/CW

h Ig h I Ig hted . * Spindle Rev - Only active when the spindle is running in reverse/CCW
2] Spindle PID will adjust the PWM output, to try and hold the commanded RPM.
* Kp is the constant proportional gain that corrects for the error amount,
* Ki corrects for the error amount summed over time,
DO n Ot use P I D * Kd corrects based upon the rate of change of the error amount.
* Recornmended initial values are Kp = 0.0000700 Ki= 0.0000000 Kd = 0.0000000
te rm S * Index Pulses per Rev is '1" unless a slotted disk or encoder channel is used.

3)In the 'Qutput Signals’ Tab, assign Aliases or Pins as needed for:
* Spindle Motor PWM (Required)
* Spindle Motor Dir (Optional)
* Spindle On (Optional)
* Spindle Fwd (Dptional)

aK Cancel




\F@_ Ethernet SmoothStepper (ESS) Configuration v283, Mach4 build 4.2.0.5036 - Instance 0

Infa General Motors Spindle Laser  Laser.. Analog Pins Config |nputSignals OutputSignals Homing Probing Backlash HC

. . 1) Set the pins Active High (Red Arrow Up) or Active Low (Green Arrow Down).
2) Give the Pins you are using an Alias: {P#-#} DESCRIPTION (This is the {Port#-Pin#} for the pin and a descrption of it) .
CO n I g a I n S This makes it MUCH EASIER to identify which pins do what in the Input and Qutput signal tabs.
3) Assign Noise Filtering, in us, for each input pin, if needed (see the 'Info’ tab for more details).
4) A Feed Held or Stop (Stop, EStop, Disabled or Limit) event can set theQutput state to 'Force ON', Force OFF', er 'No Change'
‘Mo Change' means that the output is controlled by Mach4. With 'Force ON' and 'Force OFF the ESS will force that desired state.
5) Pins are always enabled, only Signals can be enabled or disabled. Connect pins as needed on the Input and Qutput signal tabs,
S " d th Port 2 Pins 2-9 Direction Port 3 Pins 2-9 Direction
Cro Own On e O Outputs @ Inputs O Qutputs
. This is the tooltip text.. |
| ere——
P INs ta b tO see DIR Active High/Low Alias or Name Noise Filtering Stop State Fe
Port1-Pin1 Cut ? Motor 4 Step {P1-1}  |e=-e- Ne Change Mo Cha
the Port 2 Port1-Pin2 Qut ? Metor O Step {(P1-2y - Mo Change Mo Cha
. Port1-Pin3 Qut ? Meotor O Dir{P1-3y - Mo Change Mo Cha
aSSIg n l I |entS . Port1-Pind Qut T Maotor 1 Step (P-4 - Mo Change Mo Cha
Port1-Pin5 Qut T Motor 1 Dir{P1-3 - Na Change Mo Cha
Ent r |' n m Port1-Pinb Qut T Motor 2 Step (P16} |- Mo Change Mo Cha
e a IaS a es Port1-Pin7 Qut T Motor 2 Dir{P1-7v - Mo Change Mo Cha
for th ese inS Port1-Pin8 Cut T Motor 3 Step {P1-8 |- Mo Change Mo Cha
p - Port1-Pin9 Cut T Motor 3 DirfP1-9y - Ne Change Mo Cha
Port1-Pin10 In &€ E-Stop {P1-10} 000 e e
Port1-Fin11 In &€ Motor 0 ++ {P1-11} 000 e e
Port1-Pin12 In 4 Motor 1 ++ {P1-12} 000 e e
Port1-Pin13 In 4 Motor 2 ++ {P1-13} 000 e e
Port1-Pin14 Qut ? Spindle PWM{P1-14} - Na Change Mo Cha
Port1-Pin15 In & Probe {P1-15} 000 |- e
Port1-Pin16 Qut T Spindle Rev{P1-168%  |--—-- Mo Change Mo Cha
Port1-Pin17 Qut * Motor 4 Dir /P17 e Mo Chanae Mo Cha

QK Cancel




f{: Ethernet SmoothStepper (ESS) Configuration w285, Mach4 build 4.2.0.5036 - Instance 0

Info General Motors Spindle Laser  Laser.. Analog PinsConfig InputSignals Output Signals Homing Probing Backlash HC

1} Set the pins Active High (Red Arrow Up) or Active Low (Green Arrow Down).
2) Give the Pins you are using an Alias: {P#-#} DESCRIPTION (This is the {Port#-Pin#} for the pin and a descrption of it) .
- - This makes it MUCH EASIER to identify which pins do what in the Input and Qutput signal tabs.
CO n I a I n S 3) Assign Moise Filtering, in us, for each input pin, if needed (see the 'Info’ tab for more details).
4) A Feed Hold or Stop (Stop, EStop, Disabled or Limit) event can set theQutput state to 'Force ON', Force OFF, or 'No Change'.
‘Mo Change' means that the output is controlled by Machd, With 'Force ON' and 'Force OFF' the ESS will force that desired state.
5] Pins are always enabled, only Signals can be enabled or disabled. Connect pins as needed on the Input and Qutput signal tabs.
Port 2 Pins 2-9 Direction Port 3 Pins 2-9 Direction
H O Outputs @ Inputs (O Outputs
This system does not s ety ]
DIR Active High/Low Alias or Name Noise Filtering Stop State Feed Hold State
include a coolant pump " T 62 L R
Port2-Pin10 In T {P2-10} 000 eeeee e
Port2-Pin11 In T {P2-11} 000 eeeee e
Charge Pump |S a Safety Port2-Pin12 In T {P2-12} 000 e
Port2-Pin13 In ? {P2-13} 000 - e
featu re Com m On Iy knOWn Port2-Pin14 Out T P2 s Mo Change Mo Change
H
Port2-Pin15 In T {P2-15} 00 e
aS a WatCthg timer If Port2-Pin16 Cut ? Coolant On{P2-163 - No Change No Change
Port2-Pin17 Out ? Charge Pump {P2-17v - MNo Change Mo Change
MaCh4 Should Crash the Port3-Pin1 Out 3 3 s Mo Change Mo Change
Port3-Pin2 In 3 P3-2} 000 e
control logic will shutdown " T 033 I ==
Port3-Pin4 In T {P3-4} 1
all motion Port3-Pin5 In F P35} 000 e
Port3-Pin6 In T {P3-6} 000 |
Port3-Pin7 In T P37 000 |
Port3-Pin8 In T {p3-g} 000 e

oK Cancel




ESS config tab Inputs

The only input
signals are from the
limit switches and
the E-stop button.

?@_ Ethernet SmoothStepper (ESS) Configuration w285, Machd build 4.2.0.5036 - Instance 0

Info General Motors

Spindle  Laser

Laser.. Analog Pins Config

Input Signals ~ Qutput Signals

Homing Probing Backlash HC

1) When you enable an input signal here, it will automatically be enabled and mapped inte Mach,
2) An Input Pin (or Alias) may be assigned to multiple Input Signals.

E-Stop

Motor 0 Home
Motor 1 Home
Maotor 2 Home
Meotor 3 Home
Motor 4 Home
Motor 5 Home
Motor 0 ++ Limit
Motor 1 ++ Limit
Motor 2 ++ Limit
Motor 3 ++ Limit
Motor 4 ++ Limit
Motor 5 ++ Limit
Motor 0 -- Limit
Motor 1 -- Limit
Motor 2 -- Limit
Meoteor 3 -- Limit
Motor 4 -- Limit
Motor 5 -- Limit

Meoter 0 Index

Maotor 1 Index

Enable

ll“ll“lllllllllll&&&H

Mach
Mapping

ESS
ESS
ESS
ESS

ES5-only

ESS-onlv

E-Stop [P1-10}

Motor 0 ++ {P1-11}
Motor 1 ++ {P1-12}
Motor 2 ++ {P1-13}

Mapped Pin

0 Cancel



?@. Ethernet Smooth5tepper (ESS) Configuration w283, Mach4 build 4.2.0.5036 - Instance 0
Info General Motors Spindle Laser  Laser.. Analog Pins Config Input Signals Homing Probing Backlash HC
ESS 1 1) An Output Pin (or Alias) may only be assigned to a single Output Signal.
CO n fl g ta b O u t p u tS 2) An Output Signal may have up to 3 Qutput Pins (or Aliases) assigned to it:
*When enabled in this window, only 'Mapped Pin1' will be enabled and mapped into Mach.
*'Mapped Pin2' and 'Mapped Pin3' will still receive the same Qutput Signal as 'Mapped Pin1', but will net be referenced in Mach,
These outputs drive Enable M':;;:Lg Pin1 Mapping Pin2 Mapping
p Motor 0 Step wf ESS-only  Motor 0 Step {P1-2}

the motors . Motor 0 Dir of EsS-only  Motor 0 Dir {P1-3}

Motor 1 Step wf ESS-only  Motor 1 Step {P1-4}

Motor 1 Dir wf ESS-only  Motor 1 Dir{P1-5}

Motor 2 Step wf ESS-only  Motor 2 Step {P1-6}

Motor 2 Dir vf ESS-only  Motor 2 Dir {P1-7}

Motor 3 Step ef ESS-only  Motor 3 Step {P1-8}

Motor 3 Dir wf ESS-only  Maotor 3 Dir {P1-9}

Motor 4 Step e ESS-only  Motor 4 Step {P1-1}

Motor 4 Dir e ESS-only  Moter 4 Dir {P1-17}

Motor 5 Step 4 ESS5-only

Motor 5 Dir w ESS-only

Motor 0 Enable 4 ESS

Motor 1 Enable 4 ESS

Motor 2 Enable ® ESS

Motor 3 Enable ® ESS

Motor 4 Enable ® ESS

Motor 5 Enable ® ESS

ESS, XY Feed Rate PWM o ESS-only

. e — [ ree oL

oK Cancel




ESS config tab Outputs 2

Spindle and charge
pump outputs.

f@. Ethernet SmoothStepper (ESS) Configuration v283, Mach4 build 4.2.0.5036 - Instance 0

Infa General Motors Spindle  Laser

Laser.. Analog Pins Config Input Signals

Homing Probing Backla:

1) An Output Pin (or Alias) may only be assigned te a single Output Signal.
2) An Qutput Signal may have up to 3 Qutput Pins (or Aliases) assigned to it:
*When enabled in this window, only 'Mapped Pin1' will be enabled and mapped inte Mach,
*'Mapped Pin2' and 'Mapped Pin3' will still receive the same Cutput Signal as 'Mapped Pin1', but will not be referenced in Mach.

Motor 2 Enable

Motor 3 Enable

Motor 4 Enable

Motor 5 Enable

ESS. XY Feed Rate PWM

Laser PWM/XY Vel PWM/AQut1
Spindle Motor PWM Or AQut 0
Spindle Motor Dir

Spindle On

Spindle Fwd

Spindle Rev

Alarm

Charge Pump

Coolant, Flood (M08, M09)
Coolant, Mist (MO7, M09)
Current HifLow

Cut Recovery

Digitize Trigger

Dist To Go

Enable

WO KON R A A KKK KAASNKK XXX

Mach
Mapping
ESS
ESS
ESS
ESS
ESS-only
ESS-only
ES5-only
ESS-only
ESS
ESS
ESS
ESS
ES5-only
ESS
ESS
ESS
ESS
ESS
ESS

Pin1 Mapping

Spindle PWM {P1-14}
Spindle Rev {P1-16}

Charge Pump {P2-17}
Coolant On {P2-16}

Cancel

Pin2 Mapping




ESS config tab Homing

The motors in this
system do not have
an index signal.

Home operations
approach the switch
at higher speed,
then back off
slowly to make
accurate location.

@4_ Ethernet SmoothStepper (ESS) Configuration w285, Mach4 build 4.2,0.5036 - Instance 0

Info General Motors Spindle Laser  Laser.. Analog Pins Config Input Signals  Output Signals

! Probing Backlash HC

1) Homing is enabled for a Moter 'N', when the 'Input Signals' tab has:
* 'Motor N Home' Enabled with a green check.
* 'Motor N Home' has an assigned 'Mapped Pin',

2 If you have encoders with an index pulse, you may enable homing te a motor's index pin by:
* Place a green check in 'Home to Moter's Index Pin',
* Make sure that the index signal is enabled for that Motor,

Motor 0
Motor 1
Motor 2
Motor 3
Motor 4

Motor 5

Home Pin Approach
(Automatically Populated Velocity
from “Input Signals” tab) (Units/Min)

Motor 0 ++ {P1-11} 1.0
Matar 1 ++ {P1-12} 1.0

Motor 2 ++ {P1-13}

move.

Backoff
Velocity
(Units/Min)

1.0
1.0
1.0
1.0
1.0
1.0

Home To
Motor's
Index Pin

Rotational Axis
Motor Index Pin
{Automatically Populated
from 'Input Signals’ tab)

his number sets the velocity of the home

20 is a reasonable value for the PM728

Cancel



ESS config tab Backlash

We use ballscrews
with near zero
backlash.

Mach4 can
compensate for
backlash when it
exists.

W9 Ethernet SmoothStepper (E55) Configuration - v260

Info  General Motors Spindle Laser

Pins Config Input Signals  OutputSignals Homing Probing Backlash HC

1) Backlash Compensation Options

DEUse Backlash Compensation

t [ Show Backlash Comp Messages in Log

Motor 0
Motor 1
Mator 2
Motor 3
Motor 4
Motor 5

Enabled

A A A A A A&

Backlash Mac!‘. Mach . Use Custom
Amount Vt?locrtjlr Acseleratlon Values?
{Read Only) {Units/Min) {Units/Sec’2)

0.0000 501.0000 20.0000 4
0.0000 502.0000 20,0700 4
0.0000 125.0000 5.0200 4
0.0000 500.0000 20.0000 4
0.0000 15.0000 10,0000 ' 4
0.0000 15.0000 10.0000 4

1) When 'Use Backlash Compensation’ is enabled, the SmoothStepper will perform Backlash Compensation (B.C.).
Fixing backlash through software is never as effective are removing backlash with better hardware,

Custom
Velocity
{Units/Min)

10.0000
10.0000
10.0000
10.0000
10.0000
10.0000

* The first colurn, 'Enabled’, should be CHCKED if it is a normal motion axis, or if you want that moter's movements to affect B.C,

Custom

Acceleration
(Units/Sec”2)

1.0000

1.0000

1.0000

1.0000

1,0000

1.0000



Associating ESS and Mach4 connections.

We have now assigned a name to each signal connected to the ESS
Now we need to use these names to configure Mach4.

In the ESS we simply refer to motors 0-6.

Mach4 needs to associate a motor with an axis.

Select Configure->Control from Mach4 main screen.



Configure Mach4 signals- Motors

Each motor must be
configured for step
per unit and speed.

The motors
maximum velocity is
set here.

Test these values
carefully to be sure
you are not pushing

the machine too fast.

Control Configuration

Defaults General Plugins Motors  Axis Mapping Homing/Softlimits Input Signals Output Signals  Analog Inputs | * | ¥

Velocity (U/min)

Motorl
Mator2
Motor3
[ Motord
[ Motors

-nan(ind}:0.000 00:2.000
Time in Seconds

Counts Velocity Acceleration Enable
Per Unit Units/Minute  Units/(Sec™2) G Force Backlash (Units) Reverse?  Delay (ms)
2023.0000 | | 501 | | 20.00 0.05180281 || 0.0000 | n | 0

oK Cancel Apply




Configure Mach4 signals- Motors

On the prototype machine we found these values
Axis Step Vel Accel

X 2028 500 20

Y 2028 500 20

Z 8112 120 10

You should make accurate measurement by commanding a set distance and
measuring the actual move.



Configure Mach4 signals Axis Mapping

Enable each motor
and associate the
Axis with motor.

Note Mach4 supports
slave motors when
one motor is not
powerful enough for
an axis (large routers)

Control Configuration

Defaults General Plugins Motors Axis Mapping Homing/SoftLimits Input Signals Output Signals

Analeg Inputs | * | *

X (0
Y (1)
Z(2)
A3)

B (4)
C(5)
0OB1 (6)
0Bz (N
0OB3 (8)
0OB4 (9)
0B5 (10)
0B6 (11)

Enabled

Master

Motord

BB N N NN NNAA

Moterl
Motor2

Slave 4

0K

Slave 5

Cancel

Apply




Control Configuration MyMill:0
CO nfi u re M aCh4 Defaults General Plugins Motors Aux. Positions  Axis Mapping Homing/SoftLimits  Input Signals  Qutput Signals
g Mapping Enabled | Device Input Name Active Low  Log Enabled User Descriptic
Input #58 i a e
. . . Input #59 4 af uf
Associate input pins
Input #60 4 o of
with motors home nput#61 | ¥ <
T4 Input #62 ¥ 4
position. P of
Input #63 4 i of
Motor 0 Home | ef ESS Motor 0 ++ [P1-11} | 8 uf
Motor 1 Home | ef ESS Motor 1 ++ {P1-12} | 8 o
Motor 2 Home | of ESS Motor 2 ++ [P1-13) | B wf
Motor 3 Home | 3§ o wf
Motor 4 Home | 3 4 of
Motor 5 Home | 3§ o uf
Maotor 6 Home | 3§ o wf
Motor 7 Home | 3 | i of
Motor 8 Home | 3§ o wf
OK Cancel




. Contrel Cenfiguration
Conflgure MaCh4 |nPUtS 2 Defaults General Plugins Motors  Axis Mapping Homing/SoftLimits  Input Signals  Qutput Sign

Mapping Enabled | Device | Input Name | Active Low User Descr

Set the E stop Motor 29 --

Motor 30 --

Signal_ Motor 31

Probe ESS Probe

Index

Set the Probe S ——
(optional) =2 Sl L
THC Up
THC Down
Timing
Jog X+
Jog X-

KK N NN K KA XKANXK
NN KKK KKK KK KN KK

Jog ¥+

QK Ca




Configure Mach4 Spindle

Control Configuration
Set a M|n and Max Speed Input Signals  Qutput Signals Analog Inputs  Analog Outputs MPGs  Tools  Spindle  Tool Path 1
for each gear range Of the MinRPM | MaxRPM | Accel Time Decel Time | FeedBack Ratio | Reversed
. 2.00 2.00 0.00000 x
mill. 0.00 0.00 0.00000 x
0.00 0.00 0.00000 4
This value must be set to 0« 000 000 0.00000 o
0.00 0.00 0,00000 4
0.00 0.00 0,00000 ¥
These two values must be | T e %
set to 4000 7 000 000 000 0.00 0.00000 x
N 0.00 0.00 0,00000 ¥
0.00 0.00 0,00000 4
ranges. 0.00 0.00 0.00000 4
Max Spindle Motar RPM:| 00 | (] Wait on spindle to stabilize to |9C' < percent,
Spindle Override Delay: | 25 | (ms)
Set MAX Splnd|e RPM Step/Dir Spindle Axis: Mone  * (Axis must be enabled and mapped.)  [] Enable Step/Dir Spindle rigid tapping.
oK Cancel Apply




Configure Mach4

These values are
appropriate for an
automatic tool
changer.

Centrel Configuration

Input Signals  Output Signals  Analog Inputs  Analog Outputs  MPGs  Teols  Spindle  Tool Path

Max Tools

|E

Tool Change Type
(® T on ME line is next tool
()T on ME line is tool to use,

Tool Life Cancel Mumber

|‘IDD

Tool Life Restart M Code

| D

Tool Life Type Default

®) Cycle
(O Time

Tool Skip Group

(®) Current Group

() Specified

Toel Exchange Reset Signal

(®) Clears specified group.
() Clears all groups.

Life Count Override (time only)
(®) Disabled

(") Enabled

M%G Expired Condition

(®) TLCHB signal is not output.
() TLCHB signal is output.
TLCHE Signal

(®) Qutput for each tool.
() Output for the last tool in a group.

oK

Cancel

App




Generating a Mach4 license key

Mach4 is licensed software.
A license is needed for each machine.
The license is keyed to the PC it is running on.

Each system in this project was provided with a registration code that is needed to
activate a license.



Generating a Mach4 license key
Click Help->About on the Mach4

menu bar

Copy this PC ID to clipboard.

On the Machsupport.com site
paste the ID when asked.

A key file will be E-mailed to you.

About >

Mach4 Demo - CNC Control Software
5036 Unlicensed

Version: 4.
Build: 5086

For sugfort with this version, please contact:

M| MCH-106F3160-A133-DAFT-BCOA-D53CC5714648

i Copy ID T Cliphoard

Logd License File

For more information, please visit our webpage: www.machsupport.com

Load it here. —

DEMO will be changed after
license is installed.

Support email address: suppot@machsupport.com

2 Copyright 2001-2019
J Mewfanged Solutions, LLC,
Tl BN OF NEYRRLED KON All rights reserved.

0K




Mach4 license

After the license key is successfully loaded Mach4 will change references to DEMO
to your user ID.

There are some restrictions built into Mach4 DEMO that will be removed after the
license is installed.

Certain changes to the PC, replacing hard drive or net card, will change the PC_ID

This will require getting a new key from Machsupport.com



Backup

Mach4 stores all configuration values and some current operation data in a file
C:\Mach4Hobby\Profiles\MyMill\Machine.ini.

This file is saved during shutdown.

A copy is also stored in the folder \Backups in the Profile folder.

A revolving list of 20 backups are saved with a 2 digit number appended.

If you ever have a problem and want to go back to a previous version simply move
the file from \Backups to replace the current \Machine. ini, removing the 2
digit number.



Calibrating Spindle Speed

The spindle speed is controlled by a PWM signal
generated by Mach4.

A circuit on the C82 control board converts this
pulse stream to a varying DC voltage between 0 and
+10 volts.

Use the MDI window to set the machine to run at its
mid-speed, 2000 RPM

You can use the MDI command ‘S2000 M3’ to.e€
the speed.

Adjust this pot to set the speed.




Spindle Direction control

The C82 board has outputs for Forward
and Reverse run of the spindle motor.

There are two common schemes for
managing these signals, one commonly
used in the US, another in Europe.

The C82 board has two jumpers to set
this.

If set to INT the motor will only run in one
direction.

For this control the=fe ScteHse=se
to the US position.




Congratulations

You should now be ready to make parts with you new mill.

Good Luck!
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